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Welcome to the learning programme

Follow along in the guide as the training practitioner takes you through the material. Make notes and sketches that will help you to understand and remember what you have learnt. Take notes and share information with your colleagues. Important and relevant information and skills are transferred by sharing!
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This learning programme is divided into sections. Each section is preceded by a description of the required outcomes and assessment criteria as contained in the unit standards specified by the South African Qualifications Authority. These descriptions will define what you have to know and be able to do in order to be awarded the credits attached to this learning programme. These credits are regarded as building blocks towards achieving a National Qualification upon successful assessment and can never be taken away from you!
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The programme methodology includes facilitator presentations, readings, individual activities, group discussions and skill application exercises.
Know what you want to get out of the programme from the beginning and start applying your new skills immediately.  Participate as much as possible so that the learning will be interactive and stimulating.
The following principles were applied in designing the course:
Because the course is designed to maximise interactive learning, you are encouraged and required to participate fully during the group exercises
As a learner you  will be presented with numerous problems and will be required to fully apply your mind to finding solutions to problems before being presented with the course presenter’s solutions to the problems
Through participation and interaction the learners can learn as much from each other as they do from the course presenter
Although learners attending the course may have varied degrees of experience in the subject matter, the course is designed to ensure that all delegates complete the course with the same level of understanding
Because reflection forms an important component of adult learning, some learning resources will be followed by a self-assessment which is designed so that the learner will reflect on the material just completed.
This approach to course construction will ensure that learners first apply their minds to finding solutions to problems before the answers are provided, which will then maximise the learning process which is further strengthened by reflecting on the material covered by means of the self-assessments.
[bookmark: _Toc242282904][bookmark: _Toc255578170][bookmark: _Toc269888979][bookmark: _Toc318074028]Different role players in delivery process
Learner
Facilitator
Assessor
Moderator
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This learning material has also been designed to provide the learner with a comprehensive reference guide.
It is important that you take responsibility for your own learning process; this includes taking care of your learner material.  You should at all times have the following material with you:
	[image: ]Learner Guide
	This learner guide is your valuable possession:
This is your textbook and reference material, which provides you with all the information you will require to meet the exit level outcomes. 
During contact sessions, your facilitator will use this guide and will facilitate the learning process. During contact sessions a variety of activities will assist you to gain knowledge and skills. 
Follow along in the guide as the training practitioner takes you through the material. Make notes and sketches that will help you to understand and remember what you have learnt. Take and share information with your colleagues. Important and relevant information and skills are transferred by sharing!
This learning programme is divided into sections. Each section is preceded by a description of the required outcomes and assessment criteria as contained in the unit standards specified by the South African Qualifications Authority. These descriptions will define what you have to know and be able to do in order to be awarded the credits attached to this learning programme. These credits are regarded as building blocks towards achieving a National Qualification upon successful assessment and can never be taken away from you!

	[image: ]Formative Assessment Workbook

	The Formative Assessment Workbook supports the Learner Guide and assists you in applying what you have learnt. 
The formative assessment workbook contains classroom activities that you have to complete in the classroom, during contact sessions either in groups or individually.
You are required to complete all activities in the Formative Assessment Workbook. 
The facilitator will assist, lead and coach you through the process.
These activities ensure that you understand the content of the material and that you get an opportunity to test your understanding. 
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Different types of activities you can expect
To accommodate your learning preferences, a variety of different types of activities are included in the formative and summative assessments. They will assist you to achieve the outcomes (correct results) and should guide you through the learning process, making learning a positive and pleasant experience.
[image: ]
The table below provides you with more information related to the types of activities. 
	Types of Activities
	Description
	Purpose

	Knowledge Activities
[image: ]
	You are required to complete these activities on your own. 




	These activities normally test your understanding and ability to apply the information.

	[image: ]Skills Application Activities

	You need to complete these activities in the workplace 



	These activities require you to apply the knowledge  and skills  gained in the workplace

	[image: ]Natural Occurring Evidence

	You need to collect information and samples of documents from the workplace.
	These activities ensure you get the opportunity to learn from experts in the industry.
Collecting examples demonstrates how to implement knowledge and skills in a practical way
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Learner Administration 
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[bookmark: _Toc318074031]Attendance Register
You are required to sign the Attendance Register every day you attend training sessions facilitated by a facilitator. 
[bookmark: _Toc318074032]Programme Evaluation Form 
On completion you will be supplied with a “Learning programme Evaluation Form”. You are required to evaluate your experience in attending the programme.
Please complete the form at the end of the programme, as this will assist us in improving our service and programme material.  Your assistance is highly appreciated.
[bookmark: _Toc342317382][bookmark: _Toc319759688][bookmark: _Toc319319755][bookmark: _Toc342320674][bookmark: _Toc347150917][bookmark: _Toc347153937][bookmark: _Toc347316217][bookmark: _Toc66791803]Assessments
The only way to establish whether a learner is competent and has accomplished the specific outcomes is through the assessment process.  Assessment involves collecting and interpreting evidence about the learners’ ability to perform a task.
To qualify and receive credits towards your qualification, a registered Assessor will conduct an evaluation and assessment of your portfolio of evidence and competency.
[image: ]This programme has been aligned to registered unit standards.  You will be assessed against the outcomes as stipulated in the unit standard by completing assessments and by compiling a portfolio of evidence that provides proof of your ability to apply the learning to your work situation.





[bookmark: _Toc318074033]How will Assessments commence?
[bookmark: _Toc318074034]Formative Assessments 
The assessment process is easy to follow. You will be guided by the Facilitator. Your responsibility is to complete all the activities in the Formative Assessment Workbook and submit it to your facilitator. 
[bookmark: _Toc318074035]Summative Assessments 
You will be required to complete a series of summative assessments. The Summative Assessment Guide will assist you in identifying the evidence required for final assessment purposes. You will be required to complete these activities on your own time, using real life projects in your workplace or business environment in preparing evidence for your Portfolio of Evidence. Your Facilitator will provide more details in this regard.
To qualify and receive credits towards your qualification, a registered Assessor will conduct an evaluation and assessment of your portfolio of evidence and competency.
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The responsibility of learning rests with you, so be proactive and ask questions and seek assistance and help from your facilitator, if required.
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Please remember that this Skills Programme is based on outcomes based education principles which implies the following:
You are responsible for your own learning – make sure you manage your study, research and workplace time effectively. 
Learning activities are learner driven – make sure you use the Learner Guide and Formative Assessment Workbook in the manner intended, and are familiar with the workplace requirements.  
The Facilitator is there to reasonably assist you during contact, practical and workplace time for this programme – make sure that you have his/her contact details.
You are responsible for the safekeeping of your completed Formative Assessment Workbook and Workplace Guide 
If you need assistance please contact your facilitator who will gladly assist you.
[bookmark: _Toc318074038]If you have any special needs please inform the facilitator 


[bookmark: _Toc342317384][bookmark: _Toc319759690][bookmark: _Toc319319757][bookmark: _Toc342320676][bookmark: _Toc347150919][bookmark: _Toc347153939][bookmark: _Toc347316219][bookmark: _Toc66791805]Learner Expectations 
[image: ]Please prepare the following information. You will then be asked to introduce yourself to the instructor as well as your fellow learners





	Your name: 

	

	

	The organisation you represent: 

	

	

	Your position in organisation: 

	

	

	What do you hope to achieve by attending this course / what are your course expectations?
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Unit Standard Title 
Demonstrate ability to use the World Wide Web
NQF Level: 2
Credits: 3
Purpose 
People credited with this unit standard are able to : 
show knowledge of the characteristics of the World Wide Web and identify the features of a web browser 
demonstrate the ability to log on to the internet and use a browser to access the world wide web 
accomplish web search functions using a web browser and available search engine tools 
save search results by using bookmark tools 
print web pages and search reports 
Learning assumed to be in place
The credit value of this unit is based on a person having the prior knowledge and skills to operate a personal computer and a modem
Specific Outcomes and Assessment Criteria
Specific Outcome 1: Demonstrate basic knowledge about the World Wide Web and the features of a web browsing programme. 
Assessment Criteria
The nature and characteristics of the Wide World Web are explained: Limitations, filtering, control, navigation, frames
The term "Hyper Text Markup Language (HTML)" is defined and explained
The make up and structure of a web address (Universal Resource Locator - URL) are understood
The uses of a Web Browser are described
The distinctive features of a Web Browser are identified
Specific Outcome 2: Demonstrate ability to log on to internet, start browser and access web page
Assessment Criteria
A connection is established with an Internet Service Provider
The web browsing application is opened
A given web page is displayed
The web browser home page/start page is changed
Application Help Functions are used
The web browser application is closed
Specific Outcome 3: Adjust Basic Settings.
Viewing modes are changed
Toolbar display is modified
Image files are displayed in web page
Image files are not displayed in web page
Specific Outcome 4: Access a web address
A URL (Uniform Resource Locator) is opened and data is collected
A hyperlink or image link is opened
The original page is returned to
A specified site is browsed and data is collected
Specific Outcome 5: Use a search engine
Search requirements are defined
A key word is used in a search
Common logical operators are used in a search
Specific Outcome 6: Print a web page or search report
A page is previewed
Page setup options are modified
A web page is printed using basic print options
A search report is printed as a document
Specific Outcome 7: Use and create a bookmark
A bookmarked page is opened
A web page is bookmarked
Web pages are added to a bookmark folder
Unit Standard Essential Embedded Knowledge
N/A
Critical Cross-field Outcomes (CCFO)
Identify and solve problems
Work effectively with others as a member of a team, group, organisation and community
Organise and manage oneself and one`s activities responsibly and effectively
Collect, organise and critically evaluate information
Communicate effectively using visual, mathematical, and language skills in modes of oral and written presentations
Use science and technology effectively and critically (showing responsibility towards the environment and health of others). 
Demonstrate an understanding of the world as a set of related systems
Contribute to the full personal development of each learner and the social and economic development of society at large, by making it the underlying intention of any programme of learning to make an individual aware of the importance of: 
reflecting on exploring a variety of strategies to learn more effectively 
participating as responsible citizens in the life of local, national and global communities 
being culturally and aesthetically sensitive across a range of social contexts 
exploring education and career opportunities and 
developing entrepreneurial opportunities. 


[bookmark: _Toc66791807]THE WORLD WIDE WEB


Outcome
Demonstrate basic knowledge about the World Wide Web and the features of a web browsing programme
Assessment criteria
1. The nature and characteristics of the Wide World Web are explained: Limitations, filtering, control, navigation, frames
1. The term "Hyper Text Markup Language (HTML)" is defined and explained
1. The make up and structure of a web address (Universal Resource Locator - URL) are understood
1. The uses of a Web Browser are described
1. The distinctive features of a Web Browser are identified





[bookmark: _Toc125704263][bookmark: _Toc125724040][bookmark: _Toc130801697][bookmark: _Toc154193845][bookmark: _Toc171488779][bookmark: _Toc66791808]What Is The Internet?
The Internet is made up of two basic components:
1. WWW: the World Wide Web
2. e-mail
[bookmark: _Toc66791809]WWW 
The WWW is a worldwide network of websites from which you can obtain information.  A web site is made up of web pages that contain text, pictures and at times even sound and video clips.
Most corporate companies, government departments, radio and TV stations have web sites.
These web sites typically give information about the organisation, their products, current projects, future prospects, and so on.  
[bookmark: _Toc66791810]E-Mail
Electronic mail is a system of computers that are connected with the purpose of sending mail electronically.  
Many people prefer using e-mail to using snail mail (mail that goes through the Post Office), since e-mail is fun, fast and you can even send pictures and  photos via e-mail. 
[bookmark: _Toc66791811]What Do You Need To Connect To The Internet?
[image: ]A computer that is
1. Connected to the Internet via an Internet Service Provider (ISP)
2. Web browsing software
3. A telephone line
4. A modem
The most common way that people get connected to the Internet is with a telephone line.  This is called a dial-up connection.  When you connect to the Internet, you pay from the time you are connected with you ISP until you disconnect.  Luckily, the cost is for a local call and when you do this after hours, you can benefit from even cheaper Telkom rates.
[bookmark: _Toc66791812]ISP
Most people get access to the Internet through an Internet Service Provider (ISP).  Big corporate companies, universities and government departments have their own Internet connections.
[bookmark: _Toc66791813]Web Browser
A Web browser is a software application that allows you to access various web sites.  Microsoft Internet Explorer is one of the most popular web browsers, but there are other browsers available, such as Nestcape Navigator.
All the web sites are based on an HTML file. The web browser decodes the information in an HTML file and displays a web page on your computer screen according to the instructions contained in the HTML file.  We call this downloading.


[bookmark: _Toc66791814]HTML
It stands for Hypertext Markup language and is basically the programming language that allows computers to talk to each other via the Internet and your web browser.  This means that it does not matter that the software on two computers are not the same, with the web browser and HTML, the computers can communicate with each other.
This is why most web site addresses start with http
[bookmark: _Toc66791815]HTTP
A protocol name.  A protocol is a set of rules and standards that enable computers to exchange information, regardless of the software loaded on the computers. 
You can compare this to an international language enabling people all over the world to understand each other, but in the case of the Internet the computers are able to talk to each other.
[bookmark: _Toc66791816]URL
When you want to visit a friend you need to know where he/she lives; you have to know their address.
When you want to visit a web site, you need the address of the web site.  In the case of Internet, the address is called a URL.
URL is an acronym for Uniform Resource Locator and it consists of at least the following four parts:
http://www.microsoft.com/
	http:
	A protocol name (a protocol is a set of rules and standards that enable computers to exchange information)  This Web server uses Hypertext Transfer Protocol (HTTP). 

	www
	The location of the site. This site is on the World Wide Web.

	microsoft
	The Web server is at Microsoft Corporation: this is Microsoft’s web site.  This portion of the URL usually indicates who owns the web site.

	com
	A suffix that identifies the kind of organization it is (such as .com for a commercial organization) This is a commercial institution.


There are other suffixes as well, such as
.co		company 
.org	organisation
Many URL’s also contain an indication of the country where the web site is hosted:
.za		South Africa
.uk		United Kingdom


[bookmark: _Toc66791817]Cookies
[bookmark: sec_cook]Some Web sites store information in a small text file on your computer. This file is called a cookie.
A cookie is a file created by an Internet site to store information on your computer, such as your preferences when visiting that site. 
If you inquire about a flight schedule at an airline's Web site, the site might create a cookie that contains your itinerary. Or the cookie might only contain a record of the pages you looked at within the site you visited, to help the site customize the view for you the next time you visit.
Cookies can also store personally identifiable information. Personally identifiable information is information that can be used to identify or contact you, such as your name, e-mail address, home or work address, or telephone number. 
However, a Web site only has access to the personally identifiable information that you provide. A Web site cannot determine your e-mail name unless you provide it. Also, a Web site cannot gain access to other information on your computer.
Once a cookie is saved on your computer, only the Web site that created the cookie can read it.
[bookmark: _Toc66791818]Cache
Cache is memory space created on your PC by the software application to allow quick access to data
[bookmark: _Toc125704264][bookmark: _Toc125724041][bookmark: _Toc130801698][bookmark: _Toc154193846][bookmark: _Toc171488780][bookmark: _Toc66791819]Benefits Of Using The Internet
[bookmark: _Toc66791820]24-Hour Information Access
With the Internet, you can access information 24 hours a day.  It’s not like a library or organisation resource that you can only access during business hours.  You can browse the Internet any time of the day or night, over weekends and public holidays.
[bookmark: _Toc66791821]Download Speed
The speed at which information is downloaded to your computer depends on a couple of things:
How many people are browsing the Web at that time.  At certain times, such as early in the morning, downloading from the Internet is a lot quicker than at other times.  Before 8 o’clock in the morning and at night after about 9 o’ clock, 
The download speed of your modem: the faster your modem is, the faster information will download
The average download speed provided by your ISP
The size of the memory in your computer.
[bookmark: _Toc66791822]Efficient Provision Of Customer Service Information
Your organisation’s website can be set up in such a way that customers can get all the information they need about the organisation: products, general information, mission statements, etc.  
Visit  any bank’s website to see the range of information available: you can even access your banking account via the Internet.
Radio and TV stations offer information about the programmes, the presenters, competitions, actors playing in the movies.
Most websites also offer a function where you can contact the organisation by e-mail if you need more information or have requests.
[bookmark: _Toc66791823]Use Of Multimedia
Websites these days don’t only have text and colour in their web pages, they offer pictures and photos that are animated, video clips and sound clips.  Most of these can be downloaded into your computer.
[bookmark: _Toc66791824]Computer Supported Collaborative Network
With the vast amount of information available on the Internet and the ability to communicate with the people behind websites, the Internet can be viewed as a huge collaborative network that is supported by computers.
[bookmark: _Toc125704265][bookmark: _Toc125724042][bookmark: _Toc130801699][bookmark: _Toc154193847][bookmark: _Toc171488781][bookmark: _Toc66791825]Limitations Of Using The Internet
[bookmark: _Toc66791826]Identifying authoritative sources
[bookmark: pubcerts]When you download or run programs from the Internet, you want to know that the program comes from a known, reliable source. That's why, when you choose to download a program from the Internet to your computer, Internet Explorer uses Microsoft Authenticode technology to verify the identity of the program. 
Authenticode technology verifies that the program has a valid certificate: that the identity of the software publisher matches the certificate, and that the certificate is still valid. 
Note that this does not prevent a poorly written program from being downloaded or run on your computer, but it does reduce the chance of someone misrepresenting a program that is intended to be malicious or intentionally harmful.
Be careful of downloading information from sites where Internet Explorer warns you that it considers the site to be unsafe.  Rather browse some more until you find a safe site.
[bookmark: _Toc66791827]Accuracy of information
Not all websites are secure or offer accurate information.  Anybody who connects to the Internet through and ISP can set up their own websites.  This means that, although the Internet has a lot of information that can be accessed, some of the information can be inaccurate, fake or even straightforward lies.
To avoid getting inaccurate information from a website, always check the privacy policy of the site and also use a good Search Engine, such as Google.  Also, check the information by visiting more than one website.
[bookmark: _Toc66791828]Security
[bookmark: scrsites]Many Internet sites are set up to prevent unauthorized people from seeing the information that is sent to or from those sites. These are called "secure" sites. Because Internet Explorer supports the security protocols used by secure sites, you can send information to a secure site with safety and confidence.
When you visit a secure Web site, it automatically sends you its certificate, and Internet Explorer displays a lock icon on the status bar. (A certificate is a statement verifying the identity of a person or the security of a Web site.)
If you are about to send information (such as your credit card number) to an insecure site, Internet Explorer can warn you that the site is not secure. If the site claims to be secure but its security credentials are suspect, Internet Explorer can warn you that the site might have been tampered with or might be misrepresenting itself.
A Web site's privacy policy tells you what kind of information the Web site collects, to whom it gives that information, and how it uses the information. Personally identifiable information is information that can be used to identify or contact you, such as your name, e-mail address, home or work address, or telephone number. However, a Web site only has access to the personally identifiable information that you provide, or to the choices you make while visiting a Web site. For example, a Web site cannot determine your e-mail name unless you provide it. A Web site cannot gain access to other information on your computer. If a Web site collects personally identifiable information, it may store the information in a cookie, a small file that it saves on your computer.
Many Web sites provide privacy statements as written documents that you can view on the Internet. Web sites also might provide a Platform for Privacy Preferences (P3P) privacy policy. If a Web site has a P3P privacy policy, Internet Explorer can display it. Internet Explorer also might be able to compare your privacy settings to a representation of the P3P privacy policy, and determine whether or not to allow the Web site to save cookies on your computer.
To view the Privacy Report
In Internet Explorer, on the View menu, click Privacy Report. 
[bookmark: _Toc66791829]Staff time involved in using the internet
Unfortunately, searching the Web is not like making a quick phone call or sending a quick e-mail or fax.  Searching for information on the WWW is more like a long and leisurely visit with friends.
You will find that you will connect to the Internet, start surfing and before you know it you have been on the Internet for longer than an hour.
For this reason, many employers restrict Internet access, so that employees do not waste productive time by “Surfing the Web”.
Every time that you connect to the Internet, you have to be aware that time goes by very quickly.  Check the time that you have spent on the Internet regularly, search for the information you require and disconnect.
Employers expect employees to be productive for the full time they pay them to work, so don’t steal time from your employer by browsing the Web.
[bookmark: protect_ff_c_virus][bookmark: _Toc125704266][bookmark: _Toc66791830]Viruses And Trojan Horses
In today's computing world, you must prevent intentional intrusions into your computer and network that take the form of viruses and Trojan horses. 
A virus is a program that attempts to spread from computer to computer and either cause damage (by erasing or corrupting data) or annoy users (by printing messages or altering what is displayed on the screen).
A Trojan Horse is a program that masquerades as another common program in an attempt to receive information. An example of a Trojan horse is a program that behaves like a system logon to retrieve user names and password information that the writers of the Trojan horse can later use to break into the system.
Follow these tips to help prevent virus outbreaks and Trojan horse attacks.
Educate yourself about viruses and how they are commonly spread. You can unwittingly bring viruses into the network by loading a program from a source such as the Internet, online bulletin board, or e-mail attachments. 
Learn the common signs of viruses: unusual messages that appear on your screen, decreased system performance, missing data, and inability to access your hard drive. If you notice any of these problems on your computer, run your virus-detection software immediately to minimize the chances of losing data. 
Programs on floppy disks may also contain viruses. Scan all floppy disks before copying or opening files from them, or starting your computer from them. 
Have at least one commercial virus-detection program and use it regularly to check your computers for viruses. Be sure to obtain the latest virus signature files for your program when they are available, because new viruses are created every day

[bookmark: _Toc66791831]Exercise 1 
What is a Trojan Horse?
What is cache?
What is a cookie?
What is the Internet?
What is the WW?
What is a Web Browser?
What is a URL?
Give two advantages of using the Internet
Give two limitations of using the Internet


[bookmark: _Toc66791832]ACCESS A WEB PAGE AND CREATE A BOOKMARK


Outcomes 
Demonstrate ability to log on to internet, start browser and access web page
Use and create a bookmark. 

Assessment criteria
A connection is established with an Internet Service Provider
The web browsing application is opened
A given web page is displayed
The web browser home page/start page is changed
Application Help Functions are used
The web browser application is closed

A bookmarked page is opened
A web page is bookmarked
Web pages are added to a bookmark folder



[bookmark: _Toc125724044][bookmark: _Toc130801701][bookmark: _Toc154193849][bookmark: _Toc171488783][bookmark: _Toc66791833]Start Internet Explorer
On the Windows Taskbar, click Start [image: ]
Select the Internet  Explorer item at the top of the Start Menu
[bookmark: _Hlt407182080]If you are using a dial-up connection, you may be required to make a connection and log on to your Internet Service Provider.
If you want to connect, complete the required boxes and click on Connect.
Select the Internet Service Provider (ISP) you want to use to connect to the internet
Type in your Password:
Click Connect to access the internet
[image: ][image: ]If you want to work offline, Click Work Offline to browse HTML files on your PC's hard disk or company intranet
















[bookmark: _Toc467056876][bookmark: _Toc528030525][bookmark: _Toc94676268][bookmark: _Toc125704270][bookmark: _Toc125724045][bookmark: _Toc130801702][bookmark: _Toc154193850][bookmark: _Toc171488784][bookmark: _Toc66791834]The Internet Explorer Window
When the Internet Explorer web browser program is launched, a window similar to the one below is displayed. The content of the window , called the home page may be different from the one displayed below, depending on how your system is set up.
Like most Windows applications Internet Explorer has been designed to be easy to use.  You will find most of the features of other applications in the Internet Explorer application window, such as Title Bar, Menu Bar and so on.
You will also see a number of features that are unique to Internet Explorer.  These features let you browse the web.
You will notice that sometimes when Internet Explorer is run, there is a short delay while the current text and graphics comprising a page is loaded. While this occurs the Internet Explorer icon "animates" to show you that the web page is being loaded.


[bookmark: _Toc125724046][bookmark: _Toc66791835]Features that are unique to Internet Explorer
[image: ]















[image: ][image: ]Back and Forward buttons
Used to navigate forward or backward through web pages you have visited.
[image: ]Stop Button
Stop loading a page (for example, if the web page is taking a long time to load).
[image: ]Refresh
Reloads the current web page. This is useful if the page has become corrupted for whatever reason or you have stopped the whole page loading and now wish to reload it all.
If you are working offline, clicking Refresh prompts you to connect to the internet and download the latest version of the page.
[image: ]Home
Takes you directly to the page which is set as your default Home Page.
[image: ]Search
Loads the Search Assistant to look for a particular web page.
[image: ]Favourites
View a list of web pages you have stored for quick access or add a web page to this list.
[image: ]History
Shows you the web pages you have visited recently.
[image: ]Mail
Allows you to send or read e-mail and connect to newsgroups

[image: ]Print
Print a copy of the web page in the web page viewer to your default printer.
[bookmark: _Toc467056880][bookmark: _Toc528030529][bookmark: _Toc94676272][bookmark: _Toc125704274]The Address Bar
The Address bar shows the URL of the web page you are currently browsing. You can also type a URL in the Address bar and click the Go button to go to a particular website.
[image: ]
[bookmark: _Toc467056881][bookmark: _Toc528030530][bookmark: _Toc94676273][bookmark: _Toc125704275]The Links Bar
The Links bar contains shortcuts to useful internet sites. By clicking these links, Explorer allows you to quickly access these sites.
[image: ]
If there are more links than will fit on the screen, the More Links button [image: ]  will be displayed..
[bookmark: _Toc467056882][bookmark: _Toc528030531][bookmark: _Toc94676274][bookmark: _Toc125704276]The Status Bar
The Status bar displays helpful information while you work.
While a web page is being opened, the Status bar displays details of the its location and how much of the page has been downloaded (displayed in the browser window).
The Status bar also shows you whether you are connected to the internet or working offline and gives you information about how secure the current website is.
[bookmark: _Toc125704277][bookmark: _Toc94676275][bookmark: _Toc528030532][bookmark: _Toc467056883][bookmark: _Toc125724047]The Explorer Bar
When you click the Search, Favourites  or History  buttons, the Explorer bar is displayed on the left-hand side of the screen.

[image: ]















Click and drag the click-and-drag the split bar left or right to resize the Explorer bar
To close the Explorer bar, click the Close button 
To change the contents of the Explorer bar, click Search, Favorites  or History 
To browse folders on your PC/PC Network, from the View menu, select Explorer bar
From the submenu, select Folders
You can now use the Explorer bar like Windows Explorer.
[bookmark: _Toc125704279][bookmark: _Toc94676277][bookmark: _Toc528030534][bookmark: _Toc467056885][bookmark: _Toc125724048][bookmark: _Toc130801703][bookmark: _Toc154193851][bookmark: _Toc171488785][bookmark: _Toc66791836]Exiting Internet Explorer
On the Internet Explorer Title bar, click Close [image: ], or
On the Internet Explorer Title bar, click the Program Icon [image: ] and select Close, or
From the File menu, select Close 
If you are connected to the internet, a dialogue box is displayed prompting you to close the connection. Click Disconnect Now
[image: ]







[bookmark: _Toc66791837]Exercise 2
Start Internet Explorer and choose to work offline
Find the following screen elements
Address bar
Internet Explorer icon
Links bar
Status bar
Select the Search tab
Enter the keyword Favorites 
Click List Topics
Select a topic from the list then click the Display button
Read the topic displayed
Close Internet Explorer
[bookmark: _Toc125724050][bookmark: _Toc125704281][bookmark: _Toc94676280][bookmark: _Toc130801704][bookmark: _Toc154193852][bookmark: _Toc171488786][bookmark: _Toc66791838]Browsing the Web
A website is made up of pages, similar to a book.  When you move around between the pages in a website or from one website to another, it is called browsing (or navigating, or sometimes "surfing the web"). 
You can browse web pages in several different ways.
[bookmark: _Toc125724051][bookmark: _Toc66791839]Hyperlinks
Almost all web pages have hyperlinks. They connect:
One page to another part of the same page (useful if it is a really large page)
One page to another page somewhere on the web
A page to a file, such as a sound clip, video, a spreadsheet or a Word document
These links to other pages can be links to things stored anywhere on the internet. Hypertext links are indicated by underlined text highlighted in blue (usually). Hyperlinks are also frequently in the form of buttons, graphics or pictures. 
[image: ]To find hyperlinks on a page move your mouse pointer over the page and where there is a hyperlink the pointer will turn into a hand with a pointing finger.





In the example, both the graphic and the underlined text link to the same page. You could click either to follow the link.
As you surf around the web, Internet Explorer remembers where you have been. You will notice that hypertext links you previously selected are now coloured purple. Internet Explorer does this to remind you that you have already visited the page identified by this link.


[bookmark: _Toc125724052][bookmark: _Toc66791840]Navigation controls
Some websites contain many pages and therefore the designer of a website will usually put a lot of thought into creating navigation controls that allow you to move around the site. 
The navigation controls vary from website to website, however, the following controls are used regularly.
[bookmark: _Toc66791841]Navigation Panels
Navigation panels contain hyperlinks to the main sections of a website.  The panels will usually be found at the top or left-hand side of the web page. When you click links from these panels, the main body of the web page changes but the panel remains.
[image: ]
[bookmark: _Toc66791842]List Boxes
List boxes are also commonly used to navigate a website. To select what area of the site you want to go to, click down arrow on the list box and scroll through the hyperlinks to the available areas. When you have selected an area, click the Go button next to the box 
[image: ]











[bookmark: _Toc66791843]Forms (Text Boxes And Buttons)
Some websites have forms that you can enter information into.  Forms are used to:
Collect information which is sent to the owner of the website
Search databases
Play games, etc.
Some forms are very simple. Most websites contain search engines that consist of a text box where you enter text and then click on the Search button.  The request is then submitted. 
Objects in forms such as text boxes and buttons are called controls.
Other forms may be more complex, where several text boxes, list boxes, option buttons and so on are used to gather information, but they all work on the same principle: type the information into the boxes and press the button to send it. 
To move between controls use the mouse or press 
To submit the form, click the button or press 
[bookmark: _Toc66791844]Multimedia Content
Some websites may contain hyperlinks to sections with sound, video and animation. Sometimes you will be requested to download a plug-in file to browse this kind of content. A plug-in is an application that extends Internet Explorer's features.
To download the plug-in, follow the instructions on the website.  Be careful, however, since plug-ins can contain viruses.  Make sure that you are downloading from a trustworthy sites and check the plug-in with a virus scanner.
[bookmark: _Toc130801705][bookmark: _Toc154193853][bookmark: _Toc171488787][bookmark: _Toc66791845]Internet Explorer buttons
The buttons discussed in the previous section constitute Internet Explorer's own navigation controls that enable you to  revisit pages you have just been to. 
[bookmark: _Toc125704282][bookmark: _Toc94676281][bookmark: _Toc528030538][bookmark: _Toc467056889][bookmark: _Toc66791846]The Back and Forward Buttons 
Internet Explorer remembers which sites you have visited. It keeps a record of each web page as it is downloaded. Use the Back and Forward buttons to move between pages you have visited recently.
To go back and forward between web pages:
Start Internet Explorer and follow a hyperlink to another page
On the Standard toolbar, position the mouse pointer over the Back button. A ToolTip will show the name of the web page you just left.
Click the Back button and the web page you just left will be redisplayed in the web page viewer.
On the Standard toolbar, position the mouse pointer over the Forward button 
A ToolTip will show the name of the web page you just left.
Click the Forward button
The web page you just left is redisplayed in the web page viewer.
If you click the down arrow beside the Back and Forward buttons a list of pages you have just visited. Will be displayed.  You can click any page to move directly to it.
[bookmark: _Toc125704283][bookmark: _Toc94676282][bookmark: _Toc528030539][bookmark: _Toc467056890][bookmark: _Toc66791847]The Stop and Refresh Buttons
Some sites have complex graphics, sound and video which, take a long time to download.  If it is taking too long, you can click the Stop button.  As much of the web page as has currently loaded will be displayed. You may still be able to read much of the text and click on any hyperlinks that are present.
If you have already visited a site in your current internet session or even in the recent past, the graphics associated with the site will still be on your hard disk. This will enable the site to load more quickly. However, since many sites change frequently you may not be viewing the site as it currently is. 
To update the page, use the Refresh button 
[bookmark: _Toc125704284][bookmark: _Toc94676283][bookmark: _Toc528030540][bookmark: _Toc467056891][bookmark: _Toc66791848]The Home Page
The Home page is the web page that was loaded when you first started Internet Explorer. 
Do not confuse your home page with the home page of the websites you visit. Your home page is set through Internet Explorer. The home page of a website is the introductory page for the site.
If you click a hyperlink such as Home on a web page, you will jump to the website's home page, not yours.
To go to your home page, click the Home button
Change Your Home Page
You can change your home page to whatever web page you like, either on the internet, on an intranet or on your PC's hard drive.
Navigate to the page you want to use as your home page
From the Tools menu, select Internet Options...
The Internet Options dialogue box is displayed.
If not already displayed, click the General tab
Under the Home page panel, click the Use Current button
The current web page is displayed in the Address: box.
[image: ]To reset your original home page (when Internet Explorer was first installed), click the Use Default button.













[bookmark: _Toc125724053][bookmark: _Toc125704297][bookmark: _Toc94676296][bookmark: _Toc528030554][bookmark: _Toc467056905][bookmark: _Toc66791849]Jumping Directly to URLs
If you know the URL of a web page you can type it directly into Internet Explorer and jump directly to that page. This saves a lot of time than trying to "surf" to that page by following links.
On the Address bar, click into the text box
The text of the current URL is selected.
Type in a new URL and then click Go 
The Internet Explorer icon will animate and the progress of attaching to the required server will be displayed on the Status bar.  Internet Explorer saves URLs you type into the Address bar for future use.
On the Address bar, click the down arrow
Select the URL you want from the drop-down list and click Go

[image: ]
[bookmark: _Toc125724054][bookmark: _Toc125704298][bookmark: _Toc94676297][bookmark: _Toc528030555][bookmark: _Toc467056906]
[bookmark: _Toc66791850]Returning to a URL
Internet Explorer keeps a  record of the websites you visit in your History list. You can then view the contents of the list and quickly access the sites from the Explorer bar.
You can organise your History list by defining the number of days you want to save in your History list and by periodically clearing out the entries. If you find that the list has too many entries, you can delete them one at a time or all at once.
[bookmark: _Toc66791851]Jump To A URL From Your History List
On the Standard toolbar, click History , or from the View menu, select Explorer Bar then History 
The Explorer bar is displayed with the History list loaded. Web pages are grouped by day and week.
Click the calendar icon for the period you want to browse [image: ]
A list of websites browsed in that period is displayed.
Click the website icon to browse specific pages you visited [image: ]
Click the web page you want to jump to [image: ]
The web page is loaded into the web page viewer, to the right of the History list.
To close the History list, click History and the web page will be displayed across the full width of the window. You can also drag the split bar between the two panes to make the list wider or narrower

[image: ]

[bookmark: _Toc66791852]Find URLS In The History List
You can change the way the History list is organised and search for a specific URL.
· From the Explorer bar, click View and the submenu will be displayed.
[image: ]






Select an option
From the submenu, select a sort option
To find a specific URL, on the Explorer bar, click Search [image: ]
The Search panel is displayed in the Explorer bar.
In the Search for: box, type the URL (or part of a URL)
Click Search Now
The URLs matching the search text you entered are displayed.
Click the URL to browse
To return the History list to normal, click the View button and select an option


[image: ]









[bookmark: _Toc66791853]Select The Number Of Days To Keep Pages In History
You can choose how long to keep items in the History list.
From the Tools menu,  select Internet Options...
Click the General tab if not already selected
[image: ]















From the History panel, click the Days to keep pages in history down arrow or up arrow until you reach the desired number of days
Click OK
To clear the History list
From the Tools menu, select Internet Options...
On the General tab, click Clear History 
The Internet Properties dialogue box is displayed.
Click Yes
The site and page links are deleted from the History list.
To delete one History item
On the Explorer bar, right-click the item you want to delete
From the shortcut menu, click Delete
A Warning dialogue box is displayed.
Click Yes
The item is deleted.
[bookmark: _Toc125724055][bookmark: _Toc125704299][bookmark: _Toc66791854]Links to Favourite URLs
The world wide web contains millions of web pages. Despite the domain name system, remembering lots of URLs is quite difficult, which makes it hard to revisit web pages. 
While browsing the web, Internet Explorer remembers the last few locations you visited and allows you to trace your steps using the Forward and Backward buttons. However, when you exit from Internet Explorer this information is lost.
Information about the last few days browsing is stored in the History list, but you still need to sort and search the list to find the links you want.
The Favourites feature allows you to keep an address book of URLs. You can sort and organise the links so that they are easy to find. You can also keeps links to your most favourite URLs on the Links bar, for single-click access.
[bookmark: _Toc125724056][bookmark: _Toc125704300][bookmark: _Toc94676299][bookmark: _Toc528030557][bookmark: _Toc467056908][bookmark: _Toc66791855]Browsing and Creating Favourite Links
On the Standard toolbar, click Favourites, or  select the View, Explorer Bar menu. 
The Explorer bar will display with the Favourites list loaded. Links are either organised into folders or appear on their own.
Click a folder to open it [image: ]
Click a web page or document icon to browse it
If you are working offline, some links will appear faded out. If you click these links you will be prompted to connect to the internet. 
You can also select links from the Favourites menu.
[image: ]













[bookmark: _Toc125724057][bookmark: _Toc66791856]Add a link to the Favourites list
Browse to the web page
On the Standard toolbar, click Favorites  then on the Explorer bar, click Add... [image: ]
Or from the Favorites menu, select Add to Favorites...
The Add Favorite dialogue box is displayed.
You will notice it is not the URL that you see listed in the Name: text box, but the Title of the retrieved page you are viewing.
If necessary, edit or change the name so that you will remember what is on this page
Click OK
[image: ]







[bookmark: _Toc125724058][bookmark: _Toc125704301][bookmark: _Toc94676300][bookmark: _Toc528030558][bookmark: _Toc467056909][bookmark: _Toc66791857]Organising Your Favourites List
As you add more entries to favourite places it will become more convenient to organise them by related topics or categories and to create subfolders to store them in.
To Create A Favourites Folder:
On the Standard toolbar, click Favorites then on the Explorer bar, click Organize... [image: ]
Or from the Favorites menu, select Organize Favorites...
[image: ]










The Organize Favorites dialogue box is displayed.
Click Create Folder
A new folder is created in the list box on the right-hand side of the dialogue box.
Type a name and press 
Click Close
You have now created a new folder heading under which favourite places can be stored to form a submenu. 
To Move A Link To A Folder
On the Standard toolbar, click Favorites 
On the Explorer bar, click Organize... [image: ]
The Organize Favorites dialogue box is displayed.
From the list, select the link you want to move
Click Move to Folder...
The Browse for Folder dialogue box is displayed.
Select a destination folder
Click OK and then click Close
Favourites entries can also be moved between folders using the Explorer bar, by dragging and dropping them onto the required folder.
To Delete Favourite Links
As you add more and more links, there are bound to be ones you no longer want to keep.
On the Standard toolbar, click Favorites 
From the list, right-click the link or folder you want to delete then from the shortcut menu, select Delete
Or Click the link and press 
Click Yes
[image: ]


[bookmark: _Toc66791858]Getting Help
[bookmark: _Toc66791859]Browse For Help
From the Help menu, select Contents and Index 
The Internet Explorer Help window is displayed.

[image: ]



If the Contents, Index and Search tabs are not displayed, on the Help Window toolbar, click Show [image: ]
If not already selected, click the Contents tab
Click a book in the list [image: ]
Click the Help topic [image: ] you want to look at
The Help Topic is displayed on the right-hand side of the Help window.

[image: ]

Read the help and click the hyperlinks (blue, underlined text) if you want to see help on related topics
When you have finished, on the Help window Title bar, click the Close icon [image: ] to exit Help
[bookmark: _Toc66791860]Search For Help On A Particular Topic
If you are not sure where to look to find help on a particular topic, you can search for the topic using a keyword.
Open the Help window and select the Search tab
In the Type in the keyword to find: box, enter a word relevant to the topic for which you are searching

[image: ]

Click List Topics
After a few moments, the Help window displays a list of topics to select from.
In the Select Topic to display: box, select the help topic you want to look at
Click Display
You can print help topics for future reference. On the Help Window toolbar, click Options then select Print.
[bookmark: _Toc66791861]Exercise3
· From the Help menu select Contents and Index
· Select the Contents tab
· Click the Finding the Web Pages You Want book then select the Change your home page topic
· Read the help topic then look at the related topic on Favorite pages
· Click the Back button [image: ] to return to the Home Page topic
· Select the Search tab
· Enter the keyword Favorites 
· Click List Topics
· Select a topic from the list then click the Display button
· Read the topic displayed
· Close the Help window


[bookmark: _Toc130801706][bookmark: _Toc154193854][bookmark: _Toc171488788][bookmark: _Toc66791862]SEARCH ENGINES


Outcome 
Use a search engine 


Assessment criteria
Search requirements are defined
A key word is used in a search
Common logical operators are used in a search






There are millions of websites on the WWW and it grows daily, with hundred of thousands of pages of information being added every day. Since no one is in control of the Internet, it is also developing in an ad hoc and erratic way. 
This makes it very difficult for you to find the information you are looking for.  There is no index system such as you will find in a library.  Furthermore, information is duplicated and distributed amongst many thousands of different servers across of the world. 
To enable web users to locate what they are looking for, several services are available from their own websites. There are basically two types of web indexing service:
Search engines use software programs to collect information about websites and store it in a database
Web directories receive information about sites from the website developer and add it to their database
[bookmark: _Toc467056916][bookmark: _Toc528030565][bookmark: _Toc94676307][bookmark: _Toc125704304][bookmark: _Toc125724060][bookmark: _Toc130801707][bookmark: _Toc154193855][bookmark: _Toc171488789][bookmark: _Toc66791863]How Search Engines Work
Search engines are constantly browsing the WWW, looking for links embedded in various websites.  They then follow those links.  They use indexing software to add the information to a huge database that contains text, addresses and links.
When you enter a query into the search engine, you are searching in their database and not the WWW. The search engine gives you a list of URL’s in response to your query.  The response from the search engine is based on how relevant the website is to the text you typed in your query.
There are many different search engines and they use different rules to determine the relevance of a specific page to your query.
Most search engines are very good, as they are in competition with each other.  The owners of search engines get their money from advertisers who put advertisements on their website.  This means that they make sure that their search engine is easy to use and up to date.
[bookmark: _Toc66791864]Directory Sites
Directory sites do not use search engines to find websites, they accept submissions from the website designers. As the web is growing so quickly, these sites can experience problems processing submissions quickly. However, they do catalogue and organise websites and so provide a more structured approach than using a search engine.
[bookmark: _Toc66791865]Website Specific Search Tools
You will also find search tools on many websites. These usually let you search just that website for the page you are looking for.
[bookmark: _Toc467056917][bookmark: _Toc528030566][bookmark: _Toc94676308][bookmark: _Toc125704305][bookmark: _Toc125724061][bookmark: _Toc66791866]Use the Search Assistant
On the Standard toolbar, click Search 
Or Select the  View menu, Explorer Bar menu and then click Search 
The Explorer bar will show with the Search Assistant loaded.
In the Find a Web page containing: box, type a few words that describe the type of pages you want to find
What you type in the Search box will determine the kind of response you get.
Click the Search button
You will be required to connect to the internet, if you are not already connected.
The Search Assistant will perform your search and display the results. The sites that most closely match your query are listed first.
If you do not see what you want, click the Next hyperlink in the search pane (not the button on the Explorer bar) to move down the list of matches
Click the link you want
On the Explorer bar, click New  to start another search
The Search Assistant also lets you look up a word using Microsoft's Encarta encyclopaedia and search for a map or a newsgroup.
From the Choose a category for your search panel, select the relevant option button

[image: ]
[bookmark: _Toc467056918][bookmark: _Toc528030567][bookmark: _Toc94676309][bookmark: _Toc125704306][bookmark: _Toc125724062]
[bookmark: _Toc66791867]Search Operators and Syntax
When you simply type in text to locate what you want, you may quickly become frustrated at the number of links returned by the search engine.  For example, if you type “dogs” the search engine will probably give you a couple of million websites.  You have to refine the search in order to find websites relevant to your enquiry.
It helps to know what influences search results:
The query terms (words or phrases) are found near the start of the document or in the title
The document contains more of the query terms
The document contains query terms that have a high weight (words that are relatively uncommon in the database will have a high weight)
You can your searches can more satisfying if you use the correct syntax and operators. These allow you to create more detailed search criteria, specifying words to include and exclude, and searching for whole phrases rather than individual words.
Use the table and notes below to create more sophisticated searches. This syntax should work with any search engine, but click the Advanced button on the search engine's home page to check whether there are any special instructions or features.

	Syntax
	Usage
	Example

	CAPS
	Capitalise names and titles
	Rock Hudson

	,
	Use commas (,) to separate names and titles
	Bozo, Ronald McDonald

	"
	Use double quotation marks (") around phrases
	"stupid pet tricks"

	-
	Use hyphens (-) between words that must appear next to each other
	stupid-pet-tricks

	+
	Put a plus sign (+) in front of a word that must be found in the documents
	city guides +London

	-
	Put a minus sign (-) in front of a word that should not appear in the documents
	Python -Monty

	|
	Use a pipe (|) to search within a certain set of results
	dogs | Dalmatians

	*
	Use * for partial word matches
	quilt* 



Capitalise Names And Titles
Capitalise adjacent names so that the search engines treats the words as a single name or title: George Bush.  If you do not capitalise a name or title, it will be treated like any other group of words, and you will find sites about all the well-known people named George as well as all kinds of bushes
When you type your query in lower case, the search will find matches for lower case as well as capitalised words: Africa will find matches for Africa, africa and AFRICA.
As soon as you use capital letters in a search will, the engine searches for exact case matches on the entire word. 
Using Commas (,) To Separate Names And Titles.
If you want to search for several names or titles, use commas to separate them. So, to find sites that mention Thabo Mbeki and Africa, type your search as follows: Thabo Mbeki, Africa
If you do not use a comma between names, they will be treated as one long single name. 
Double Quotations
Use double quotation marks (") around words or hyphens (-) between words that must appear next to each other.
Using quotes or hyphens requires that words appear together. Type: "stupid pet tricks" or stupid-pet-tricks to find sites with those words adjacent to each other. Otherwise, the search engine will find sites that include the word stupid, the word pet, and the word tricks. 
When using hyphens, be sure you leave no spaces between the words.
Use A Plus Sign (+) In Front Of A Word That Must Appear
To require a word, and increase the precision of your search, type: city guides +London
Do not leave a space between the plus sign and the word that must appear. 

Use A Minus Sign (-) In Front Of A Word That Must Not Appear
To exclude a word from your search, type: Python -Monty
This will find you sites on the programming language, not the British comedy group. 
Do not leave a space between the minus sign and the word you wish to exclude. 
Using A Pipe (|) To Search A Certain Set Of Results Only
To narrow your search results by searching for one word, and then within that set of results, for another, type: dogs | Dalmatians 
Using An Asterisk * To Search For Partial Matches
This query matches sites that contain at least one word such as quilt, quilts, quilting, quilted, quilter and so on: quilt*
The * notation is also useful for searching for variant spellings. For example, alumi*m will find matches for both the British English aluminium and American English aluminum.
[bookmark: _Toc467056919][bookmark: _Toc528030568][bookmark: _Toc94676310][bookmark: _Toc125724063][bookmark: _Toc66791868]Using Different Search Engines
Through the Search Assistant you can get quick access to several powerful search engines to perform quick searches. However the results displayed in the Explorer bar are generally not as detailed as those found on the search engine's actual website. Also, for some searches you may want to use a different type of search engine.
You can use a different search engine by browsing to the relevant website. This section gives you a few examples of different search engines and how to use them.
Excite
In the Address bar, enter the following URL and click Go 




[image: ]www.excite.co.uk
















The Excite Home Page will display
In the Search box, enter your search text and select a zone from the drop-down list
Click Search 
The results of your search will be displayed on a new web page.
You will see that there is a short extract from the web page to help you decide whether it is relevant.
HotBot
When you use HotBot you do not have to enter any search syntax. You can select search criteria from drop-down list boxes, and also select what sort of files to look for (sound, video, pictures and so on).
Their URL is
www.hotbot.com
[bookmark: _Toc467056920][bookmark: _Toc528030569][bookmark: _Toc94676311][bookmark: _Toc125704307][bookmark: _Toc125724064][bookmark: _Toc66791869]
Using a Web Directory
Yahoo is an example of a web directory, where they rely on submissions from website designers rather than a web search engine. The web pages in its database are organised into hierarchies. You can either follow the hyperlinks to browse a specific category for pages, or use the search tool to locate a web page in its database 
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Their URL is:

www.yahoo.co.uk
OR   
www.yahoo.com
Click the hyperlinks to browse the topic you are interested in
Or enter search text to find web pages in the directory

[bookmark: _Toc66791870]Exercises SO4
What is the difference between a web directory and a search engine?
Give one example of a search engine
Give one example of a web directory



[bookmark: _Toc66791871]PRINT A WEB PAGE


Outcome 
Print a web page or search report

Assessment criteria
A page is previewed
Page setup options are modified
A web page is printed using basic print options
A search report is printed as a document















Staying connected to the internet can be very expensive.  At times you will find that there are certain sites you visit often. In this case, you can select to browse them offline.  Using the synchronising function, you download the site onto your PC and save it on the hard disk. Now you can disconnect from the internet and read the web pages at your leisure.
You can also update your downloaded version of the site to keep it current with the version on the web. This is called synchronising.
It is also possible to download files that are freely available to your PC. 
[bookmark: _Toc467056922][bookmark: _Toc528030571][bookmark: _Toc94676313][bookmark: _Toc125704309][bookmark: _Toc125724066][bookmark: _Toc130801709][bookmark: _Toc154193857][bookmark: _Toc171488791][bookmark: _Toc66791872]Browsing a Website Offline
To browse a website offline, you must add it to your Favourites list.  Set up a website for offline browsing:
Open the home page of the website (or a specific web page) to which you want to subscribe
On the Standard toolbar, click Favorites  then on the Explorer bar, click Add
Or select the Favourites, Add to Favourites menu. The dialogue box will display
If required, you can edit or change the name so that you will remember what is on this page
Then click the Make available offline check box
If you just want to make a single web page available, click OK now
To make an entire website available for offline browsing, click Customize
The Offline Favorite Wizard is displayed.  Click Next > 
The next page of the wizard is displayed.
Select the Yes option button
Enter a number in the links deep box to select how many "layers" of the site to include.  Leave this number set to 1 or 2 unless you have a lot of disk space and are willing to spend a long time downloading the site.
Click Next >
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Choose whether to update the offline content manually or using a schedule then click Next>
If you chose to create a schedule, enter the details here then click Next >
If the site contains sensitive content you may want to protect entry to it with a password.
Enter the password details in the relevant boxes
Do not forget your password and user name, or you will not be able to access the website
[image: ]












Click Finish
Click OK to close the Add Favorite dialogue box
The Synchronizing dialogue box is displayed while Internet Explorer downloads the site.
Click Stop if you need to cancel the download
Otherwise wait until the download is complete
When the site is downloaded, Internet Explorer should disconnect from the internet automatically. You can now browse the site offline.
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[bookmark: _Toc130801710][bookmark: _Toc154193858][bookmark: _Toc171488792][bookmark: _Toc66791873]To Make Existing Links Available Offline
On the Standard toolbar, click Favorites 
The Explorer bar is displayed with the Favorites list loaded. 
Right-click the relevant link and select Make available offline
Complete each step of the Offline Favorite Wizard
[bookmark: _Toc130801711][bookmark: _Toc154193859][bookmark: _Toc171488793][bookmark: _Toc66791874]To Work Offline
You can switch between offline and online browsing without exiting Internet Explorer.
From the File menu, select Work Offline
The Working Offline icon [image: ] is displayed on the Status bar.
Selecting Work Offline does not always disconnect you from the internet. To check whether you are connected, display the Windows Taskbar. If this icon [image: ] is displayed then you are still connected. Right-click the icon and select Disconnect.
[bookmark: _Toc125704311][bookmark: _Toc125724067]If you select an online link you will be prompted to connect to the internet again automatically.


[bookmark: _Toc130801712][bookmark: _Toc154193860][bookmark: _Toc171488794][bookmark: _Toc66791875]Saving, Editing and Printing Pages
You can also save a web page as an HTML file on your PC.
Browse to thepage you want to save
From the File menu, select Save As...
he Save Web Page dialogue box is displayed.
Enter a file name and select a folder
In the Save as type box, select Web page, complete to save the page and any associated graphics or Web page, HTML only to save the page's underlying code only
Click Save
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[bookmark: _Toc130801713][bookmark: _Toc154193861][bookmark: _Toc171488795][bookmark: _Toc66791876]Save A Graphic To Your PC
· Right click on the graphic on the web page
· Save the picture to your hard drive
[bookmark: _Toc130801714][bookmark: _Toc154193862][bookmark: _Toc171488796][bookmark: _Toc66791877]To Print A Page
On the Standard toolbar, click Print or select the File, Print menu
The page will print out to your default printer. If you need to set more advanced print options, or change your printer, follow the steps below.
If you are browsing a web page with frames, you have the option of printing the contents of each frame separately or as they appear on the screen
If you select Print all linked documents, Internet Explorer will print all the pages in that website (this could use a lot of paper)
Select the printer you want to use and the number of copies then click OK
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[bookmark: _Toc125724068][bookmark: _Toc130801715][bookmark: _Toc154193863][bookmark: _Toc171488797][bookmark: _Toc66791878]Opening HTML Files
As well as browsing web pages, you can use Internet Explorer to view HTML files saved on your PC's disk or to a network folder.
From the File menu, select Open 
The Open dialogue box is displayed.
From the Look in: box, select the folder containing the HTML file
Select the file and click Open
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[bookmark: _Toc66791879]Exercises 5
How would you browse a web page offline?
How would you print a web page?



[bookmark: _Toc66791880][bookmark: _Toc154193864][bookmark: _Toc171488798]LEGAL AND ETHICAL ISSUES 

THIS SECTION IS INCLUDED FOR INFORMATION ONLY
Outcome 
Explain legal and ethical issues in relation to Internet use



Assessment criteria
Explain the implications of various acts, in terms of using information from the Internet
Explain the implications of providing Internet access to individuals in terms of security of information, and virus protection
Explain security considerations of using the Internet















To start of this section herewith a quote from an article in SA Computer Magazine Vol. 13 #8 Dec 2005 by Marlon Cohen
[bookmark: _Toc130801716][bookmark: _Toc154193865][bookmark: _Toc171488799][bookmark: _Toc66791881]Cyber-crime
[bookmark: _Toc66791882]Hacking and phishing offenders under fire.
Synatec’s biannual Internet security report (released on 21 March) revealed that Website phishing is up by approximately 366% worldwide.  It is believed the phising, together with hacking into sites and databases are carried out especially to compromise the integrity of corporate and personal information, and therefore will continue to rise.
The drafters of the Electronic Communications and transactions (ECT) Act specifically saw hacking and related unauthorised access to data as a serious problem.  Accordingly, the ECT Act is specifically geared to protect against these issues.
In terms of the Act, a number of actions by an individual are made illegal and are therefore offences under the Act.  These are:
Any person who intentionally accesses or intercepts any data without authority or permission to do so (access is defined as “[including] the actions of a person who, after taking note of any data, becomes aware of the fact that he or she is not authorised to access that data and still continues to access that data”)
Any person who intentionally and without authority to do so, interferes with data in a way which causes such data to be modified, destroyed or otherwise rendered ineffective;
Any person who unlawfully produces, designs, sells or distributes a device (which includes software) which is designed to overcome security measures to protect data (including breaking passwords or access codes); and
An act or any of the actions referred to above with the intent of creating a denial of service.
It is therefore clear that the conventional ideas of hacking and phishing are illegal in terms of the Act, as well as other related activities such as developing software to enable those illegal activities.  
In addition, where any person uses one of the activities above to gain an unlawful proprietary advantage’, he /she will be committing an offence.  In other words where a person uses or threatens to use one of the activities above to gain an advantage over a competitor, he/she will be acting illegally.  In addition, any data that is intentionally faked to gain a competitive advantage would be illegal.
The Act lastly also covers any person aiding or abetting someone who is performing any of these illegal acts.
The penalties for committing these offences differ, with the offences carrying a penalty of a fine and/or imprisonment of between one and five years.
[bookmark: _Toc66791883]Cyber Inspectors
Chapter XII of the Act also establishes what are referred to as cyber inspectors.  These are people employed by the Department of Communications who are to ‘police’ the provisions of the Act.  
The cyber inspectors are empowered to amongst other things:
Monitor and inspect any Website or activity n an information system ‘in the public domain’ and report any unlawful activity to the appropriate authorities; and
Ensure compliance with the Act by cryptography and accreditation service providers.
The cyber inspectors may also obtain assistance from the police in their duties, and obtain warrants to:
Inspect and search an individual’s premises (and information system);
Inspect records on an information system; and 
Obtain access to computers which are believed to be connected to an offence.
A person who fails to cooperate with a lawful search and seizures is guilty of an offence under the Act. 
It is therefore foreseeable that the cyber inspectors, together with the police, are empowered by this Act to track down and investigate anyone who is believed to be hacking or phising.
[bookmark: _Toc130801717][bookmark: _Toc154193866][bookmark: _Toc171488800][bookmark: _Toc66791884]Website Content
Herewith an article about copying website content and using it word for word without acknowledging the author of the content.



Website copyright infringement beware 

29th August 2005 – 

In one of the first cases of its kind in South Africa, a company accused of online copyright infringement has paid an out-of-court cash settlement to the copyright owner. www.FindanAdvisor.co.za, billed as South Africa‚s premier online Financial Advisor directory, recently took legal action against another directory site, for what it saw as a direct breach of its intellectual property. The alleged wrongdoer purportedly copied, word for word, a large piece of text from FindanAdvisor’s website and distributed such as part of an email newsletter for its own marketing campaign. 
Up until now, website content has been pretty much a free-for-all. The ease of copying and pasting from millions of online sources has exploded. Copying images from the web also contravenes copyright. 
Everybody, from plagiarising post-graduate students to bogus overnight medical experts, has participated. Many are unaware that they are in fact breaching the law, but, as internet business gets more serious, more litigation of this nature can be expected. 
Specialist companies have even sprung up overseas that scout the web for copyright infringers and then report them to the original content owners (presumably for a commission). If found guilty, offenders can be sued for up to three or four years of royalty fees, or even more if financial loss can be proven. 

Parties making use of content from websites need to quote the source of the content, and preferably provide a link back to the source website. Most web authors will be content with the publicity and incoming link. However, in order to be completely watertight, express authorisation by the author of the content needs to be obtained. 
With the worldwide web being such a huge place, content authors who have had their work plagiarised are seldom aware that their rights have been infringed. A good way (but not guaranteed) to find out is to type a long sentence of your text into a few good search engines and see what comes up. In theory the search should render no results, unless of course somebody came up with the identical sentence on their own accord. If not speak to your lawyer! 
FindanAdvisor.co.za is pleased with the settlement and is continuing to establish itself as a top class portal for members of the South African public needing to make an informed, un-pressured and proactive choice about which financial advisor or broker to appoint. 
Reputable financial advisors around the country are also benefiting from the exposure they are getting to a growing, astute and affluent segment of the South African population. 
In fact, the website has had such success that a sister site, FindanAccountant.co.za, is due to be launched in the next month. This information is distributed for and on behalf of FinandAdvisor. For further info please Contact Chris Preen Tel 021-7832183 or chris@FindanAdvisor.co.za 
[bookmark: _Toc130801718][bookmark: _Toc154193867][bookmark: _Toc171488801][bookmark: _Toc66791885]Copying files
On the following pages you will find an article from the January 2006 issue of SA Computer magazine that deals with the legal issues regarding copying files through what is called P2P or peer to peer trading of content.
Although most of the legal action here took place overseas, it is worth taking note of it, analysing it and discussing it in groups since we have to stay up to date on world events.
[bookmark: _Toc130801719][bookmark: _Toc154193868][bookmark: _Toc171488802][bookmark: _Toc66791886]Escrow
There is also an article that was published by SA Computer magazine in December 2005 and concerns intellectual property.  This is not common practice in South Africa and the article is included for the sake of interest only.
[bookmark: _Toc130801720][bookmark: _Toc154193869][bookmark: _Toc171488803][bookmark: _Toc66791887]PROATIA
The last article is from SA Computer magazine of September 2005 regarding the various Acts regarding the Internet, information and access to information, including the South African Constitution.
[bookmark: _Toc66791888]Exercise 6
In groups, discuss the various articles quoted and the implications thereof on copyright, access to information and copying Web content word for word.  Make notes of your conclusions for your assessments.
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ing, 2 whole body of ltgaton has developed inthe United Sttes.

Napster
aprter provided software os weil o5 operated o centroised
sotabase thot indexed fies avaiobie for doniooding from

users’ computers. In 2000, vorkous portes sued Nopster for opy-

right infingement. The courtin A&M Records v Nopster found
thot regardiess of what the peering network wos intended to be
used for, Nogster

© Had actual knowledge tha the s ccessed were being copied/

omnloaded, and therefore was ey infinging on the content

omners copyright;and

Matcrially contributed t infringement by providing 4 s with

indexing of the sites nd fles valabe for downloading,

Grokster
"o o g e offn 2003 o Gt
Unlike Napaer,Grokter dd'e povide» centralsed databas o s
evilble for downioading, nstad, ser connccted 10d uplosded

e 0 supernodes’thatbeloged 1 wcrs on that network.

In MGM v Grokater, the court came to3 ifeeotdecivion to
Napate ac heldtha Grokoer wasi lsbe fo copyright fringe.
meat. The rationse beind the jodgement ws that
+ Grokterdidit conrolanysccest 4 datsbase o index I

fles 0 be downloaded,

+ 1§ Grokoterwer b closd donen, the software s sevice could

ill be viedfor sharig; and
+ Tewas o sffcendly poved that Grokser had ressonable kol

edie’of pecfic frnging Bles on ser computes.

As sl of the Grokote cas,the Recoding Icustry Asocision
of Americ o thousards of it sgaint individal Bl sarer.

1 June 2005, the Grokoercas went on sppeal before the US
Appesl Court. In this instance, the cour unanimouslyoveruled the
ower court'sdecision and found that Grokser wa ity of copyright
infringement becase:

* Grokoter marketed self 1 n alirnative to Napaer, and thercfore

Kncw tha s srvice could b usedfor copyright nfringement;

* No cffortwas made by Grokoerto e ot copyrighted material
from wsen dowriosds and

© Even thnsgh Grokster might have had o acrusl knowledge of
infringemcor, it wasforesesble tht the oftware would be used
forllcgal purpose.

g of

A sacwinuavioos

“The decision ofthe court was no techaclogy spcific and would
therfore seem 1 apply o any software provider cnablng copyright
infringement.
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Its uses in a business environment

scro agreements are ot cormmonly knoran o wsed i Sonth.
 Africa, mostly duc o ignorance omthe part ofboth software

developers and buyer. It s cxpected tht s frms become more sware
ofthe poential vaue of thei ntellectul property,these types of
agrecments will become more poguiar

“The strcture of an escrow agreement normally fllows these lines
st party undertakes o deponit information type subect mat-
e with  trusted excrow agen for safekeeping, the ccromw agent
will keep the information sae and confidenia, and will not relesse
the information o the second party unil it s proven o the escrow

action that 1 trigger event” has oxcurred.

s wide varity of situationsin which an ecrow agreement
may be wsed. Typicaly, one of the more common examples would

b where  software buye purchass and install softwar from 3
software developer, and the software i mportant o cven critical o
the proper functioning of the buyer’s busines proceses. The buyer
wonld pormally expect tha, s the busiess changes,the oftwire
would be customised to dape o the businessprocess changes 1 the
buyer docss't have an in-house IT development team,the bayer will
410 el on the developer o b sble to make the modifications nd
Customisations that are required.

Hawever, if anything should happen to the developer (uch 15
inolvency, a takeover, and the lke), the buyer would be lft i 4 pre-
carious position. The buyer wil not have any scces t th source code
ofthe softwar, nd would ot b in  position to mosify o forther
develop the software,or even ixbgs for that mateer. The buyer may
be forced nto  position of hving to buy the ource code from the
iquidatorofthe developer, nd the whereabouts of the source code
may not even b clear, much s the whereaboutsofthe source code
pertainiog o the vrsion that the buyer has insalld!

I such s cas, the triggerevent would be the something lke the
winding up of the developer, o the withdrawal of the developer
businessiterestsfrom the country. Th escrow sgrecment may
reqie the developer to depost the mostup-to-date version of the
source code with the xcrow agent st regular time interval,to e
ha th verion i excrow is ot technologically obsoet.

Homwever, escromw agreements may be used in othe stuations,
such 1 the regulardeposit o sftware by 1 devcloper to sppesse the
concerns of n ivestor who i payig for the deelopment of the st
ware I this way,th hvestor cnsars tht he will have st least some
access o the information andlorcode that he has paidfo ifsnything.
should go wrong, The trigger cvent in such  cas would obviously be
diffcrent from the types described sbove, but would b thought ot 10
cortespond 0 ‘wonst cas scenarc’

Avcxhergood cxampl s where ane srvice provider company s
espomsible for the operation of nother customer femissoftware (.
Inteet Service Providers) I carying ou thei services,  sbstantal
armenin of nformation may be compued (for examgie 3 database of
contact names) The database may belong  the customerfirm, bt

Should anything go wrong and the seviceprovidr not be in 3 posiion
Gegally orpractically) o hand th information o the cusomer, o
should  dispute arse between th paries,thethe cusomes may ind
himscl dangerously exposed n the busines sere, where contnuity of
the busincesprocescs may be important. I fct, wherever processs
arc cutsonrced, i an sgrecment may prove extremely vabible

1 uch  cse, the customer would only have 0 approach the
escrow gt 10 scces the vabsble information and b sbie o e
ment thirbusincssprocesss again with 3 diffrent sevice provider
afer minimum downtime

Tt shoukd be noted that,while any trustworthy person o instieution
(s0ch 2 ttorneysor  bank) may be used 1030 xcrow agene, masy
of these may notbe properly prepared and structured fo the ongoing
sorage and quick etrieval of software. For businesscritcal processes
s

Escrow agrecments are sl no limied t software or dars. Where
4 business s dependent o technology o know-how, which s pro-
vided by n upstecam supplicr, then this technaogy may aao be de-
ponited with an cxcromw agent 0 safeguard the downstream business

In the information age, where busincsses ae depersent on their
abiliy to ccess information, e forethought can go 4 loug way i
ensuring the continued srviva o your busincss. - SACH

Mike Biagio

slecd Popery Asoners

scrom agents re recommended

MUSCH
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Access to information

How to get what you need

lause 31(1) of the South African Constitu-
tion statesthat “Everyone hasthe right of

access 10 (a) any information held by the state, and
(b) any information that s held by another person
and thati required for the excrcise or protection of
any rights.”

In order 0 cxpand on thisright, the South
Afiican legislature promuligated the Promotion of
Access o Information Act (or PROATIA),

Whom does the Act apply to!
ROATIA goes further thn the msjrity of
simila legislationin other countrics, and is

ot only applcable to public bodics, but also ap-

plis 0 private bodics. As  esul, anyone condoct-
ing 2 business (whether online orin the traditional
business workd) would nccd o comply with the
provisions of the Act, and specificaly the manner
inwhich information is granted.

What data/information can be requested!
Act applies - any record held by a private
body, regardless of when tha record came nto
existence.

A second s defned a:

1) Any recorded informaion;

2) Regardlessof form or medium;

3) That s in the possession or under the control of
the private body; and

4) Whether or not that information was created
by thatprivate body:

“The definiion i wide and would include
information such as e-mails and sored informa-
tion kept by the company. All four clements of the
definition must however be present for the data
concerned to be defined 18 3 record' i terms of
PROATIA.

Who can request the record!
ny person, including her cormpany o+
publc body may request the record.

“The requeser of information i only entited to

the record i

1) The recond is requied fo the exercis or pro-

tection ofaright;

2) The person complies with the procedural re-
quirements relating to requesting information
in the Act; and

3) The requestis not refused on the grounds of
refusal st out i the Act.

In addition to requesting a record, 4 person may
alo request any personal information that the

‘company may have about him o her.

How do you request the information!?
I 1 terms of the Act, allprivate bodics must
compile a manual settng out the procedures
for obtaining information from tha private body,
and must make that manual avilable t the private
body's premises and on its Websit i it has onc).
In terms of additional regulations under the Act,
privat bodies have until 31 August 2005 within
which to submit these manuals (which need to be
submitted t0 the South African Human Rights
Commisson).

PROATIA was amended in 2004 and now sates
that a head of a private body *..who wilfully and
oin a grosly negligent manner ais to comply
with (the provisions of the Act rlating to the
PROATIA manual) commits an offence and sl
able on conviction 1 a fine, or o imprisonment for
2 period ot exceeding two years”

Although the criteria for non-compliance are
high,the penaltics for non-compliance are harsh,
and it i suggested that companies tryto comply
with the requirements if they have not done s0.

How does the request for information workl
ask bl is tha the requeste ofinfor-
mation hast requesttheinformation in a
specific format (which s set out in the private
body's manual) and has t pay the private body the
prescibed request fee.

“The head o the prvate body must within 30
daysof receving the request decide whether to
rant the request ornot, and advise the requester
of that decision. PROATIA aeo sets out the man-
erin which you can extend th tme to btsin
the records, a well asthe appeal process if you
can' givethe requesterthe records. I, however,




